Edison Local
Schools

Facilities Advisory Committee 2022
Committee Process & Data Overview




Objective: Provide an OFCC-informed Master Plan
Recommendation(s) to School Board by April 19.

Essential Considerations:

« Grade Configuration(s) & Location(s)

« Educational Quality & Classroom Impact

« Overall Cost of Project -> ‘Millage’ / Cost to Taxpayers
« Community Opinion (Anecdotal & Research)

* Maintaining Status Quo vs. Taking Action




Facilities Committee Process:

Meeting 1. Situational Overview + Detailed OFCC Reports

-Enrollment & trend, Facility Benefits/Drawbacks, Teacher/Custodial quotes,
OFCC funding guidelines, District financial considerations/overview.

Meeting 2: Answer Qs & Build the “Ideal” Master Plan (Groups)

-Student map, Answers to FAC Questions, Results of In-Depth Interviews with local
leaders, Teacher Licensure Certification/Configuration, Group Discussion & report

Meeting 3. Pros/Cons of Proposed Scenarios  (Groups)

-Assess “Fit Plans” of site renovations/construction, Review estimated millage,
state v. local share, Group Discussion & report, Voting Demographic data

Meeting 4: Online Survey Results & Master Plan Voting

-Review of Online Survey results, Review of Options, Round 1 of Voting, Elimination
from 5 -> 2 options, Round 2 of Voting




Registered Voter Data (Ohio Sec of State)

Location

Milan Township
Milan Village

Berlin Township
Berlin Heights
Morwalk Township
Morwalk City
Oxford Township
Florence Township
Vermilion Township

TOTAL
Party Affiliation REGISTRATION
Democrat 6,399 Voters

Republican
Other/None




In-Depth Interviews: Findings



In-Depth Interviews: Findings
« Completed 16 Interviews, (Outreach to 56), 35-40 minutes, Feb 17-28
 District is Moving in the Right Direction.
« High-Quality of Education, among best academic offerings in region.

» Very strong sense of ‘community’ — but some harbor concerns about
lingering disharmony around ‘consolidation’ of district.

« Excellent & Caring teaching staff, repeatedly offered.

» Generally High Marks for Management of Funds -
acknowledgement that passing tax issues a long-term issue. Most
common examples of poor spending surround, ironically, maintaining
and repairing old facilities.



I_n-Depth Interviews: Findings

All recognized buildings are generally old and/or in poor condition.

General understanding that the High School is in the best condition..
Support for renovations there due to recent investments.

More openness to building new elementary & middle schools

Many stated it is important to them and to their community that a
building remains in each community (Berlin Heights & Vlg. of Milan)

Most agreed that up-to-date buildings are linked to educational
quality, but believe teachers and parental involvement matter more.

Cost to get up-to-date buildings may exceed what is palatable, and
the costs may be rising, and timing is critical.



I_n-Depth Interviews: Findings

« Many IDEALLY would aim for a single-location plan... but believe a
single site plan may not be supported across the communities.

« Concerns that local businesses could be negatively impacted if
school facilities located on single, Milan Township (HS) campus.

« Fears that the community as a whole could be hurt by the loss of a
school site, could remove sense of community identity.

« Ask FAC to listen, to be respectful, to seek pragmatic decision-
making, remind that compromise is important.



Online Community Survey:
Findings



Survey Methodology

* Live survey link emailed to key communicators, printed in
the local paper, posted to social media.

* Online April 1-11.
1,089 Responses.
« Responses verified via IP addresses; no ‘stuffing’.

« Self-selected sample, but closely resembles electorate.




Very large sample (N=1,084) for size of district (6,400 voters).

Overall survey participation oversamples Parents and high-affinity
supporters (alumni, grandparents, staff), and likely undersamples
65+ portion of community (28%).

Survey participation by Milan (Village+Twp) and Berlin
(Heights+Twp) match registered voter counts nearly identically.

O Survey: 45% Milan / 36% Berlin / 18% Other
O Voter Reg: 43% Milan / 37% Berlin / 19% Other




How long have you lived in Edison Local School District?




Which describe your affiliation with the school?

Parent of a child/children who are too young for school

Parent of a current student/students 46.7%

Employed by the Edison Schools (Teacher, Administrator,
Support Staff)

Student
Resident of the district (no students in the household)

Business owner/operator in the district

Other (Please specify) 12.5%
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100.0%



In which community do you live?

13.2%

Village of
W IETY

32.4%

19.0%

. Other (most frequent responses)
: Milan
Berlin Townshi 1. Norwalk
~ Township ‘ P 2. Huron County

3. Oxford Township
17.0% 4. Sandusky

Berlin Heights




About 80-90% of participants have been inside the buildings within the last 5
years, with ES/MS on lower end and HS on higher end.

Overall, about 15% are unsure about the physical condition of the buildings.

Majority feel High School is in a good (23%) or minor repair (40%) condition...
and only 7% feel it needs replaced.

By comparison, the Elementary and Middle Schools have plurality agreement
that they need replaced (46% and 35% respectively), or at least major repairs
are called for (19%, 22%).




Please indicate what condition you think each of the three Edison school buildings are in.

Edison Elementary School

Edison Middle School

Edison High School

0.0% 20.0% 40.0% 60.0% 80.0% 100.0%

®m Good Condition ~ m Needs Minor Repairs ~ ®m Needs Major Repairs ~ m Needs Replaced Don't know/Unsure



Quality of Education gets an “A/A-": Excellent (53%) or Good (40%).

Name Change of District improved overall sense of community (57%), but
notable chunk disagreed (18%)

They trust the district to use tax dollars wisely (55%); unsure (24%); and they
believe community simply CAN afford new buildings (53%)... but, many are
unsure (23%) or doubtful (21%).

Keeping up with technology is important for student futures - unanimously
agree (67% strongly agree, 31% agree); now is the time to find a long term solution
to building problems, rather than constant fixes (52% strongly agree, 33% agree)

Having a school in both communities doesn't matter to everyone (36% + 21%),
but matters A LOT to a large portion/plurality (43%).




Overall how would you rate the quality of education in Edison Local Schools?

0.8%1.4%
4.1%

Excellent

® Excellent ™ Good ™ Only Fair ®m Poor = Unsure



Please indicate whether you strongly agree, agree, disagree or strongly disagree

with the following statements:

[~
T
|
T

1 T T T T 1

0.0% 20.0% 40.0% 60.0% 80.0% 100.0%

It is important to me to have a school building in each
community (Berlin Hts and Milan)

Changing the name of the district from the Berlin-Milan Schools
to Edison improved the sense of community

Keeping up with technology is important to prepare students
for their futures

| don’t trust the schools to spend dollars wisely

m Strongly Agree  ®m Agree  m Disagree  m Strongly Disagree Neither Agree or Disagree



Please indicate whether you strongly agree, agree, disagree or strongly disagree
with the following statements:

It is time to find a long term solution to building problems,
rather than focus on short term fixes

33.0% 'HI7.4%
The current school buildings provide adequate teaching and
. . .6% 28.8% 30.0% 14.9%
learning environments
1% - 22.9%

T T T T 1

0.0% 20.0% 40.0% 60.0% 80.0% 100.0%

Our community simply cannot afford new school buildings

m Strongly Agree  m Agree  m Disagree  m Strongly Disagree Neither Agree or Disagree



Forced Ranking -> forces honest weighing of priorities. We force participants to
weigh all 2 “importance” topics surrounding facilities planning.

Next chart shows how close each of the topics gets to the MOST important
(“Providing the best learning/teaching environments”). Cost of Project clear #2 in
importance. Finding a plan community supports and building energy efficient
schools about even in third.

Preserving historical aspects of building ranks lowest, just behind keeping a
building in Village of Milan and keeping building in Berlin Heights.

Bottom Line: Location matters TREMENDOUSLY for those in Berlin Heights,
SOMEWHAT for those in Village of Milan, and NOT TOO MUCH in Milan Twp.




As the district makes decisions about how to move forward with a facilities plan, please
rank how important these are to YOU. (top 5)

L
100.0%
80.0%
60.0%
40.0%
20.0%
0.0%
Providingthe Overall cost of Seekinga plan Building energy Securingthe  Maintaining Ensuring a Ensuring a Preserving
best learning  the facilities  the community efficient schools  27% match timely building building historical
and teaching project s willing to vote from the state transportation remainsin  remainsinthe  aspects of
environments for to build to their toandfrom  Berlin Heights Village of Milan  buildings
standards school

SsGoSurvey



Berlin Heights

62.9%
58.5% 57.2%

47.8%

Providing the Overall cost of Ensuringa Seekinga plan  Building Securingthe  Ensuringa  Maintaining  Preserving

best learning the facilities building the energy 27% match building timely historical

and teaching project remains in communityis  efficient  from the state remains in the transportation aspects of

environments Berlin Heights willing to vote schools to build to Village of  toand from buildings
for their Milan school

standards



Berlin Township

76.4% 72.6%

67.3%
63.0%

57.1% 56.0%
49.3%

Providing the Overall cost of Ensuringa Seekinga plan  Building Securing the Maintaining  Ensuring a Preserving

best learning the facilities building the energy 27% match timely building historical

and teaching project remainsin communityis  efficient from the statetransportationremains in the aspects of

environments Berlin Heights willing to vote  schools to buildto  toand from Village of buildings
for their school Milan

standards



Village of Milan

83.1%

Providing the Overall cost of Seeking a plan  Building Securingthe Ensuringa  Maintaining  Ensuring a Preserving

best learning the facilities the energy 27% match building timely building historical

and teaching project community is  efficient from the stateremains in thetransportation remainsin aspects of

environments willing to vote  schools to build to Village of  to and from Berlin Heights  buildings
for their Milan school

standards



Milan Township

Providing the Overall cost of  Building Securing the Seeking a plan Maintaining  Ensuring a Preserving Ensuring a

best learning the facilities energy 27% match the timely building historical building

and teaching project efficient  from the state community is transportationremains in the aspects of remains in

environments schools to build to  willing to vote to and from Village of buildings  Berlin Heights
their for school Milan

standards



All things being equal, with random distribution, all ranks/categories would
get about 111 votes each. The gap between random distribution (111) and
participant responses really show how important each one is to specific
portions of community.

HQ Learn. Environs -> Clearly #1, very few rank below R5
Cost of Project -> Strong #2, even spread cluster at top
Energy Efficient -> Rarely Rank 1, clearly step behind cost

Comm. Support/State Match/Transportation -> comfortably in the middle

Berlin Hts -> 123 votes as R1 + 79 votes R2... it matters a lot to 20%, but
the rest put it in the bottom 2 ranks.

Village of Milan -> a similar pattern with lower intensity, fewer R1




S_urvey Data -> “Ranking”
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Provided (3 pts) and 1 Yellow (1 pts) stickable dot.
Allows 15t choice / 2"d choice prioritization among options.
Included 2 proxy votes, requested the prior week.

NO CLEAR FAVORITE in Round 1. Eliminated Option 2,4,5

Round 2. Same Green/Yellow voting process.
Includes 3 votes cast online by FAC members who missed
the meeting, using private link, 24-hour time limit.



Est. Millage: 8.41
Est. Cost: $24.47/mo

*per $100,000 assessed value

Option 2

New PK-8

Reno HS
(1 site)

Total Cost: $81.3M
OFCC Share: $21.2 M
Local Share: $60.1 M

Est. Millage: 9.10
Est. Cost: $26.79/mo

*per $100,000 assessed value

Est. Millage: 8.31
Est. Cost: $24.25/mo

*per $100,000 assessed value

Votes

Option 4

New PK-5, New 6-8

Reno HS
(3 sites)

Total Cost: $85.0 M
OFCC Share: $21.2M
Local Share: $63.8 M

Est. Millage: 9.66
Est. Cost: $28.44/mo

*per $100,000 assessed value

Estimate 2022 Costs
*Assumes 37 Year Bond



